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1. INTRODUCTION

MultiFlo Mass Flow Controllers (MFC) allow considerable reduction of controller inventory. MultiFlo 
MFCs can be easily programmed by a PC computer to the desired gas and range. The MultiFlo 
Inventory Solution consists of a set of 9 standard MFCs called SCs (Standard Configurations) and 
a simple software kit, the MultiFlo Configurator. The MultiFlo Configurator software kit is used to 
program the SCs to the desired gas and range and produces a label that identifies the programmed
MFC. The MultiFlo Configurator software runs on PCs with Windows® 9X/ME/2000/XP™ or NT4.0 
SP6.0 or above. A printer and blank label stock, selected to meet the environmental requirement of
gas boxes, is included.

The 9 standard SCs cover most gases and ranges from 3 sccm (actual) to 30 slm (full scale) 
Nitrogen equivalent. First, the user connects the selected MFC to the computer. The user enters the
desired gas and range onto the main screen of the MultiFlo Configurator software. The software 
designates the SC number that is required for the desired gas and range. The software then auto
matically configures the attached SC MFC. The MultiFlo Configurator can only configure SC type 
MFCs. SCs are specially configured to work with the MultiFlo Configurator and will provide the same
performance as a MFC that was factory calibrated and tuned for a specific gas and range. The 
MultiFlo Configurator cannot be used with MultiFlo MFCs that are not configured as SCs or be used
with standard single gas calibrated MFCs.

The gas and flow range for an MFC can be set through its built-in RS-485 or DeviceNet interface. 
This facilitates the configuration of a single MFC for applications requiring different gases and 
flow rates. Each MFC in your inventory provides the functionality of many different controllers. Your 
inventory of just a few MFC models can support all of your requirements.

The MultiFlo Configurator's software programming allows quick and effective reconfiguration of the 
gas and range settings. The Configurator also prints identification labels for the current 
configurations.

This User Guide details how to install and use both the MFC software and hardware.

1.1. Description of MultiFlo Configurator kit

The MultiFlo Configurator kit P/N 535-400-2004 includes:

-  MultiFlo Configurator software (CD-ROM) P/N 350-301-2000 (User's Manual is included in
the CD as a Help File with Complete installation of software) 

-  DeviceNet Cable/Connector/Power Supply Kit P/N 535-001-0001 
-  RS232/RS485 Protocol Converter P/N 900-235-1193 
-  RS485 cable P/N 955-001-0018 
-  URS-20 Power Supply 
-  7' CardEdge Cable 
-  Zebra TLP2844-Z printer or equivalent P/N 001-152-1001 
-  500-label set roll with high strength adhesive P/N 540-300-1058 
-  Anti-wipe ink ribbon for Zebra TLP2844-Z P/N 001-152-2003 
-  Printer cable P/N 001-152-3000 
-  Laptop Computer P/N 300-001-0005
There are many other MultiFlo Configurator Accessory kit solutions available, contact your 
Celerity sales representative.

 



©2005 Celerity, Inc. #199-002-0003 REVH 2/05 2

1.2. Elements of a Configurator System

A typical Configurator system is shown below.

The Configurator system contains the following elements: 

- A personal computer (PC) running Windows® 9X/ME/2000/XP™ or NT4.0 SP6.0 or above. 
The MultiFlo Configurator software requires 3 MB of free disk space. A 486 or Pentium CPU
with at least 32 MB of RAM is an adequate platform. The computer must have a CD drive 
for software installation and an available serial COM port to be dedicated to communication 
with the MFC. 

- A software CD for initial installation of the MultiFlo Configurator Software. 
- An RS-232/RS-485 Protocol Converter connected to the computer. 
- An RS-485 cable from the Protocol Converter RS-485 output to the MFC under 

configuration. 
- A power supply for the MFC under configuration. 
- A shielded cable with 20 Pin female PCB end connector from the MFC power supply to the 

MFC, typically +15Vdc @ 300mA and -15Vdc @ 100mA. 
- A Zebra TLP-2844Z printer to print labels. 
- Printer cable to connect to the Zebra printer.

Figure 1.1 MultiFlo Configurator accessory kit p/n 535-400-2002
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1.3 Using this Manual

This manual contains instructions for installing and operating the software on your PC, and 
setting up the system for configuring MFCs. Once the installation has been completed 
successfully, your PC can be used to rapidly configure MFCs.

Angle brackets (such as <Button>) refer to selecting that particular on-screen command 
button. Square brackets [Menu] refer to moving to the menu option specified. Curly brackets 
{Field} enclose the name of a data entry or display field into which input or select information
is entered.

On most screens, your PC's <Enter> key signifies completion of a particular selection.

2. INSTALLING SOFTWARE

2.1. Installing MultiFlo Configurator Software From CD. Installation CD-Browser.

Upon inserting MultiFlo Configurator Software into your CD drive, a demo movie will begin. If 
you have the auto-start function disabled, explore to: [your CD drive]:\Launch.exe, and 
double-click to start.

This opens the Main Page of the CD-browser. Select from the menu on the left (red circle on 
left) to access various pages. Use the Up and Down arrows (smaller circle on lower right) to 
advance or back-step through text.

- Using the mouse, select “INSTALL SOFTWARE” and click to enter this page. 

.

Figure 2.1 Installation CD-Browser. MAIN screen Highlights
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Read instructions (use up and down arrows on lower right). Click on Install Configurator 
Software Button (highlighted in red circle) to Install.

- The ABOUT PRINTER section includes the directions shown below in section 2.3. 
- The ABOUT MULTIFLO section includes information and a step-by-step demo of the 

directions shown below in section 4. 
- The ABOUT CELERITY section includes information about Celerity Group, Inc. 
- The CONTACT US section includes an active link to our website. 

2.2. Running Setup.exe. Installing MultiFlo Configurator Software to your computer.

Using either the Installation CD-browser or simply exploring to the Setup.exe file and double-
clicking will start the InstallShield installation of the MultiFlo Configurator Software.

4

Figure 2.2 Installation CD-Browser. INSTALL SOFTWARE screen Highlights
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-Click <Next> to continue. Click <Cancel> at any time to abort and exit the installation.

- You must accept the license agreement in order to continue, otherwise, you can not 
continue.

- After you check “I accept …” , then click <Next> (now active) to continue.

5

Figure 2.3 Welcome to Installation

Figure 2.4 License Agreement
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- Please enter your User Name and Organization. Select for your single use or for anyone on 
your computer. Click <Next> to continue.

- Select “Complete” to include help file with your installation. Otherwise select “Typical” to 
minimize the space required on your system. “Custom” installation is not recommended.

- Click <Next> to continue.

6

Figure 2.5 Customer Information

Figure 2.6 Setup Type
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- Click <Install> to begin installation.
- If you receive Error Message 1911 "Could not Register Type Library", please click 

<IGNORE> and continue.

- Click <Finish> to end.

- Proceed to Section 2.3 to Install the Zebra Printer.

7

Figure 2.7 Ready to Install

Figure 2.8 Installation Completed
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2.3. Installing Printer Software

2.3.1 Setting up Printer Software for Windows®  system.

Read through the Printer Installation instructions BEFORE proceeding.   

- Follow instructions in TKS002-0049 RevA:  Users Guide for Zebra Printers P/N -001-152-
1001:  Zebra Model TLP 2844-Z. 

- Attach Power Supply; 
- Load Roll Media (labels); 
- Load Ribbon (Thermal Transfer Media); and 
- Power up. 

- Your Zebra Printer was Calibrated for Label Media P/N 540-300-1058 (Thermal Labels, 1X 
3/8” 3 across) at the Celerity Factory.

*DO NOT POWER ON THE ZEBRA PRINTER.

- Load the Thermal Ribbon per installation instructions (TKS002-0049 RevA). Insure that the 
notches sit firmly in the roller guide, or a red light “out of media” error will occur. 

- Load the Label Media. 
- Firmly close the Lid to the Printer. 
- Connect the Printer Cable to the Computer Printer Port 
- Connect the Power cord to the Printer. 

*DO NOT POWER ON THE ZEBRA PRINTER.

- Load CD labelled "Bar Code Label Printers Software and Documnetation" into CD-ROM 
drive. 

- If Autostart is not active, explore to [CD]:\setup.exe and double-click on setup.exe. 
- From the Main menu select "TLP 2844-Z" from Model menu. Double-click on "Windows 

Drivers".

8

Figure 2.9 Zebra Setup.exe
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- Select desired language from menu. Click <OK> to continue.

- The Printer Setup Wizard screen appears. Click <Next> to continue.

- The Digital Signature Not Found warning appears. Click <Yes> to Continue.

Figure 2.10 Language Selection Menu

Figure 2.11 Printer Setup Wizard.

Figure 2.12 Digital Signature Not Found warning.
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- Select "LPT1" for the Printer Port. Click <Next> to continue.

- The Printer Name should auto-fill, otherwise, type "Zebra TLP2844-Z".
Click <Next> to continue.

Figure 2.13 Printer Port selection.

Figure 2.14 Printer Name setup.

 



- The Configuration Assistant Wizard now appears. Click <Next> to continue. 

- Select "User Defined" Label Size from the menu. Click <Next> to continue.
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Figure 2.15 Configuration Assistant Wizard.

Figure 2.16 Label Setup 
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- For Top Adjustment, enter a value of "0" and click <Next> to continue.

- Select "Tear Off" for Dispense Mode, and click <Next> to continue.

12

Figure 2.17 Top Adjustment 

Figure 2.18 Dispense Mode selection
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- Select "Thermal Transfer" from the menu for Media Type. Click <Next> to continue.

- Select Continuous label type for Media Tracking. Click <Next> to continue.

13

Figure 2.19 Media Type selection.

Figure 2.20 Media Tracking selection.
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- The Complete Configuration Assistant Wizard screen appears. Click <Finish> to continue.

- Do Not "Print Test Page', click <Finish> to complete. 

- Now, Restart your computer, and 
- Power-On (switch in rear of printer), the printer.  
- When the computer restarts, the Hardware Wizard will recognize the printer. 
- Test the Printer. Copy the file, "TestZebra.txt" to the C:\ drive (from C:\Program 

Files\Celerity\MutliFlo\ZebraTLP2844Z) 
- Open a dos-command window by opening Start >Run. Type "cmd" (no quotes) and click 

on <OK>. Type "C:" (no quotes), the cmd.exe window should show: C:\>. Type "Copy 
TestZebra.txt LPT1", the cmd.exe window should show: 1 file(s) copied. A single row of 
labels with 'Zebra" printed on them will print out. 

14

Figure 2.21 Completing Configuration Assistant Wizard.

Figure 2.22 Print Test 
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- If no labels print out, check the printer cable connection.  
- Double-check that the printer is configured to LPT1 (use Start >Settings>Printers. select the

Zebra TLP2844-Z and select Properties, then the Port tab) 
- Finally, reconfigure the LPT port, shown below (section 2.6)

Installing Hardware

WARNING: WHEN INSTALLING AND REMOVING CABLES TO AND FROM YOUR PC, MAKE SURE THE
PC IS POWERED OFF TO PREVENT DAMAGE TO THE PC AND ASSOCIATED EQUIPMENT.

2.4. Installing Configurator Hardware

Refer to Figure 1.1 and use the following procedure to install the Configurator hardware to 
the PC.  

- Connect the RS-232/RS-485 Protocol Converter to the PC serial port and then to the RS-
232/RS-485 Protocol Converter. 

- Connect the Protocol Converter power cord to a standard 110 VAC power outlet. 
- Connect the Power Supply for the MFC to a standard 110 VAC power outlet. 

2.5. Installing the MFC

Note: It is not necessary to turn off the PC when installing and removing the MFC to and from
the Configurator hardware. 

Refer to Figure 1.1 and use the following procedure to install the MFC to the Configurator 
hardware.  

- Connect the RS-485 cable between the Protocol Converter and the MFC. 
- Connect the ribbon power cable from the power supply to the MFC. 

2.6. Reconfiguring the LPT Port

On some newer systems the default printer port is 'ECP Printer Port'. If the printer is not 
responding to commands then the ECP Printer Port is probably the problem. 

See below for the necessary steps that need to be taken in order to reconfigure your LPT 
printer port. It's best that this port be dedicated to the Zebra printer because other ports 
might expect the ECP to be loaded in order to properly operate.

1. Click <Start> button, select <Settings>, select <Control Panel>.
2. Double-Click the <System> icon to launch the <System Properties> form.
3. Click the <Device Manager> tab to display the list of devices.
4. Click the '+' sign to the right of <Ports (Com & LPT)> to expand the list.
5. Select <Printer Port>, then click the <Properties> button.

15



©2005 Celerity, Inc. #199-002-0003 REVH 2/05

6. Click the <Driver> tab, then Click the <Update Driver> command button to launch the 
Update Device Driver Wizard, and then Click <Next> to continue.

7. Select <Display a list of all the drivers in a specific location, so you can select the driver 
you want> option, Click <Next> to continue.

8. Select <Show all hardware>, Select <Printer Port>, and then Click <Next> to continue.

16

Figure 2.23 System Properties form shows a list of all the devices associated with your machine. 
Select the desired Printer Port, typically LPT1, and then click the Properties button.

Figure 2.24 Update Device Driver Wizard form shows the options that need to be selected and the Printer Port 
model that needs to be selected.
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9. Select <Printer Port>
10. Click <Next>, Click <Next> and Click <Finish>.

Your new Printer Port configuration is now completed, try printing again. If still unable to 
print, please contact a service representative or technical support person for assistance.

3. PRINTER SETUP

It is no longer necessary to update any settings in the computer setup for the print jobs.

After successfully completing this chapter set of instructions and the printer still doesn't respond, 
make sure that the LPT port is not set to ECP or EPP or the printer might not work properly. Try 
configuring the LPT port to either 'Uni-Directional' or 'Bi-Directional' for proper operation. Refer to 
Reconfiguring the LPT Port section for more details.

4. USING THE MULTIFLO CONFIGURATOR SOFTWARE

When the Configurator software is required for use, click the "MultiFlo Configurator" icon on your 
Windows desktop. This will launch the MultiFlo Configurator program.

Once the software has been installed and the MFC communication and power cables connected, 
configuring an MFC is quick and easy. 

Only MultiFlo MFCs configured as SCs (Standard Configuration MFC) can be configured by the 
MultiFlo Configurator Software. SCs can be recognized by SC## code on the manufacturing label on
the side of the can. Applicable SCs are designated from number 01 to 20. Check the MultiFlo 
Inventory solution on how to order SCs. 

The SC Configuration steps are listed below:

- Connect the SC (refer to Paragraph 3.2) to your computer. 
- Start the software. 
- Select the gas type and flow range. The software will display instructions requesting connection of 

the SC it has selected. If no MFC corresponds to the selected gas type and flow range, a red error
message will indicate that the range is inappropriate. If desired, select a desired process gas page.
(*Note: acknowledgement messages will appear with any selection that is NOT "First Available".) 

- Click the <Configure> button. The software will automatically configure the SC while displaying a 
status screen (Fig. 4.7) showing the progress of the automatic configuration. 

- When automatic configuration is complete, the program will indicate that the MFC is ready for use 
by displaying a "Configuration Successfully Completed!" message (Fig. 4.9). The [File/Print] menu 
option allows printing of a label for the MFC if desired. 

After returning to the main menu, the MFC may then be disconnected and is ready for production 
use. 

17
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4.1. Selection Screen

Initially, the Celerity Tool MultiFlo Configurator displays the following Selection Screen upon 
startup. This screen provides Communication Port selection and MacID Selection of MFCs.
This MFC selection screen gives information on all devices currently connected on the 
selected port. It is no longer necessary to remove single devices from a network and connect 
directly to the PC in order to reconfigure MultiFlo MFCs.

18

Figure 4.1

Figure 4.2
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The upper text box gives status messages. The desired port may be selected from the pull 
down list of all available ports. The last selected port is the default setting. If necessary, use 
[Options] > [Refresh_Grid] to update the data displayed following a change in port selection. 

After searching the selected Port, a list of the MFC Mac ID's and status will be listed. Scroll 
down the grid list to see all available devices. The selected MFC Mac ID is displayed in the 
central box with details.

19

Figure 4.4

Figure 4.3
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To Change the Selected MFC, use the Pull-down menu. The page data will be updated 
automatically (purple highlight). 

To Program Gas and Range for the Selected MFC MacID, press the "Go To MultiFlo 
Configurator Program" button. This will launch the single MFC MultiFlo Configurator 
program at which point you must enter your logon password to begin to configure MFCs, if 
you have activated password protection. Otherwise, you will continue directly to the Main 
Page. 

20

Figure 4.5
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4.2. Configuration Screen 

Initially, the Configurator displays the following Main Screen, unless the Password Protection 
option has been selected. (See section 4.4) This screen provides gas selection and 
configuration options for MFCs and gives access to various program options.

- {MFC Device Type} Displays the current MFC model type: MultiFlo MFC or IFC-125. 
- {Gas} Select from the list of available gases. 
- {Range} Input the Desired Flow Range in the currently selected units. 
- <SCCM/SLM> Units: Click one of these buttons to select units of Standard Cubic 

Centimeters per Minute (SCCM) or Standard Liters per Minute (SLM). 
- <Gas View> You have a number of options for viewing the selected gas. You may view it as 

Name/Description, Symbol + Name, Symbol + Gas Code or Gas Code + Symbol, whichever 
method suits your needs the best. 

- {Page} Select from the list of available process gas pages. The default and recommended 
setting is "First Available". 

- [File] Click to display the menu which includes: "Configure", "Password", "View Details", 
"Print Setup", "Reset Units" and "Exit". 

- [Help] Click to display the menu to view the About Configurator screen for the software. 
- <Configure> Configure the currently identified MFC for the desired new process gas. 
- <Exit> Exit from the Main Configurator screen and return to the MFC selection screen. 

The toolbar across the top offers shortcuts to the following menu selections: Configuration, 
Password, Printer Setup, View Details. 

21

Figure 4.6. Typical Main Screen for Digital MultiFlo MFC.
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For digital communication only, a baudrate selection box is available. The Default value is 
"optimize".

A feature of the MultiFlo Configurator alerts the user to crossovers between SC configurations 
where a SC bin higher or lower could also be used for the gas and range specified. (Fig. 4.7) 
It is recommended that the primary SC bin be selected/used when possible for optimal 
performance. 

The User simply selects the desired gas from the gas selection box; enters the desired range 
value, and selects the desired units. The software displays the Primary SC Unit required for 
the desired gas and range (and Alternate SC Unit will be displayed if available for the given 
gas and range). The User may select the process gas page (if desired). Then click on 
<Configure> to program the selected MFC to the gas and range requested. 

22

Figure 4.6a Toolbar Details, Main Screen.

Figure 4.7 Sample screen view where an alternate bin is available for a single gas and range.
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The MultiFlo Configurator Alert message shown below is displayed during configuration, only 
IF the user has chosen a process gas page that is NOT "First Available". The user must 
acknowledge that: overwriting process gas page #1 will delete the process gas page utilized 
for incoming inspection; and/or that selecting other process gas pages may over write 
existing/previously configured gas pages. To agree and continue, click on <Yes>, or to step 
back, click on <No>.

During automatic configuration, the MultiFlo Configuration in Progress Screen (below) is 
displayed. Various update messages and a blue-colored progress bar show the current step in
the configuration sequence. The <Cancel> button may be used to abort the configuration 
process before it is completed.

Automatic configuration takes only a few moments (typically < 1 min.). When complete, the 
Print Label Screen (Fig. 4.10) will be displayed.

23

Figure 4.8b Alert message when any available Process Gas Page is selected (not "First Available").

Figure 4.8a Alert message when Process Gas Page #1 is selected.

Figure 4.9
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4.3 Printing Labels

The Configurator software indicates that automatic configuration is complete by displaying the
Print Label Screen shown here.

- {Customer Part #} Enter the part number to be printed on the labels. This field can be 
edited. Default value is customer part number entered during production process.  

- <Print Setup> View the Printer setup on computer.   
- <Print> Print the labels. 
- <Preview> Open the Print Preview screen of the labels. 
- <Details> Open the View Details screen which displays of all process gas pages in the MFC.

Allows the user to change the current active page and also to delete pages. 
- <Return> Close the screen and returns to the Main Page. 

24

Figure 4.10

Figure 4.11 Print Preview Screen
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*New Feature* 

- <Label with Orientation> Fills the third line of the label with the 3-letter orientation code.  
Deactivates editing ability until <Print> command is executed.

- [Printer Adjust] menu select [Offset Adjust] to bring up Printer Offset Adjust screen. This 
screen enters vertical and horizontal offsets for the Zebra Printer. Once values are entered, 
they are stored in the computer. Type in values, click <Enter Values> to store. Click <Exit> 
to close window and return.
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Figure 4.10a Label with Orientation Button

Figure 4.11a Preview of Label with Orientation

Figure 4.11c Printer Offset Adjust



©2005 Celerity, Inc. #199-002-0003 REVH 2/05

4.4. Detail Screen  

To view the Detail Screen, from the Print Label Screen, click <Details>. Alternatively, from 
the Main Configurator Screen (Section 4.2), under [File], select [View Details] to access this 
screen, or select the View Details button from the toolbar.

The Details Screen now appears. The top display box gives information on the currently active
process gas page. The lower grid lists information on all the process gas pages currently con
figured on the connected MFC device.

*New Feature*  

Inlet Pressure Limits and Outlet Pressure data is now displayed for the MFC. Minimum and 
Maximum Inlet pressure values and units are shown for the process gas page, as well as the 
outlet pressure setting.(MinInlet, MaxInlet, PUnits, Outlet)

Scroll up or down to see all available pages. The top box on the page highlights details for the
current active page. Left-mouse-click and drag to select a cell range and then right-mouse-
click to Activate or Delete a page. 
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Figure 4.12 Details Screen
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In order to delete Page 1 (Incoming inspection calibration data page), the Alert message 
must be acknowledged by selecting <Yes> to agree or select <No> to decline. 

If the current active gas page is selected a warning message will alert the user. The current 
active process gas page can not be deleted. If the current active gas page is selected, a 
warning message will alert the user. The user must select to activate a different process gas 
page in order to delete that first selected process gas page.

When finished, click <Close> to close the View Details screen and return to previous screen.
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Figure 4.13

Figure 4.14
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4.5. Password Protection

The password option allows controlled access to the program so that unauthorized personnel 
cannot configure MFCs. Select the Password Icon.

Alternately, the password feature may be accessed from [File] > [Password]

.
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Figure 4.15

Figure 4.16

Figure 4.17 
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- {Password} Enter the logon password (default password 12341234). 
- <Change> Display the Change Password screen (Fig. 4.17). 
- <OK> Complete the logon password process and continue with program operation. 
- <Exit> Quit program operation. 
- {Old Password} This field is not enabled when the program is used for the first time. 

After the password has been established, this field is available sshould it be required to 
change to a new password. 

- {New Password} Enter the password. 
- {Verification} Enter the password again. 
- <OK> Complete the password selection process and continue with program operation. 
- <Cancel> Quit program operation without creating a new password.

After a new Password is entered on the Change Password screen, the Password Logon screen
will appear (Fig 4.18). Once the logon password has been specified, this Logon screen will be
displayed each time you start the MultiFlo Configurator software.

29

Figure 4.18
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4.6. Obtaining Help

From the "MFC Selection for MultiFlo Configurator" page, the Help menu selection "About" 
displays the following "About Configurator" screen, which contains the version of your 
Configurator software and other related information.

- <OK> Close the About Configurator screen. 

From the MultiFlo Configurator Main Page, the [Help] menu also includes a [Manual] menu 
option for accessing this MultiFlo Configurator software Help file. Click on <Open 
HelpViewer> to open a browser to view the helpfile.  

Context-sensitive help is available as well by hovering the mouse over any item of question, 
which will bring up a tool tip display after 2 seconds.  
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Figure 4.19

Figure 4.20
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*New Feature* 

4.7 Reset Units:  SCCM/SLM vs. ACCM/ALM

Typical units are sccm or slm. A sccm is defined as: standard* cubic centimeter per minute.
*Standard conditions: 0 °C and 760 torr (1 atmosphere). A slm is for a liter. An accm is 
defined as: actual* cubic centimeter per minute.  *Actual conditions: XX.X °C and 760 torr 
(1 atmosphere). Alm is liter.

To change between sccm/slm and accm/alm with reference Temperature, use the Reset Unit 
command. [File] menu select [Reset Units].

The Input accm/alm parameters screen display. Type the Reference Temperatur value and 
units. Click <Enter Value> to set the Reference Temperature Value, the value will appear in 
bold format when stored. If a return to sccm/slm units is desired, click on <Reset to sccm>.  
Click on <Return> to return to the Main Configurator Page.
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Figure 4.21 Reset Units Menu.

Figure 4.22 Input Reference Temperature for accm/alm units.
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The Main Configurator Page now displays accm/alm and includes a Reference Temperature 

(always displayed in degree C).

The Reference Temperature is readable in the View Details screen. Reference Temperature 
values are displayed in a column hidden on the right side of the screen. Scroll to right using 

the right arrow (red highlight). Reference Temperature is always set to degree Celsius.
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Figure 4.23 Main Configuration screen with Reference Temperature for accm/alm units

Figure 4.24 View Details screen with Reference Temperature data. (For sccm/slm units, the Ref. Temp is 
always 0 C.)
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*New Feature* 

4.8 Options for IFC-125C Series Controllers

As a standard option of Celerity's Gas Delivery Module, the UNIT 125 integrated flow 
controller integrates PTI technology and MultiFlo Technology.

For IFC-125C type controllers, the MultiFlo Configurator software has additional functions 
available. Select the IFC normally from the Select MFC page. When the Main Page loads, 

added features are automatically displayed when the MFC Device Type is "IFC-125C".

This screen provides gas selection and configuration options for the IFC-125C controller.
- {MFC Device Type} Displays the current MFC model type: MultiFlo MFC or IFC-125. 
- {Gas} Select from the list of available gases. 
- {Range} Input the Desired Flow Range in the currently selected units. 
- <SCCM/SLM> Units: Click one of these buttons to select units of Standard Cubic 

Centimeters per Minute (SCCM) or Standard Liters per Minute (SLM). 
- <Gas View> A number of options are available for viewing the selected gas:  

Name/Description, Symbol + Name, Symbol + Gas Code or Gas Code + Symbol 
- {Page} Select from the list of available process gas pages. The default and recommended 

setting is "First Available". 
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Figure 4.25 Typical Main Screen for IFC-125C series MFC.
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*New Feature*

- {Min. Inlet Press.} Minimum Inlet Pressure for gas entering MFC 
- {Max. Inlet Press.} Maximum Inlet Pressure for gas entering MFC 
- {Pressure Units} select either psig, psia or torr. 
- {Outlet Pressure} select either vacuum or atmosphere. 
- {Orientation}  Only available if the IFC-125 controller is ordered as CFG (configurable) or 

HOS (Horizontal On Side) or HOV (Horizontol On Vertical). For CFG, the following options 
are available: VIU, VID, HBD, HLD, HLU, HUD, HED. For HOS, the options are: HBD, 
HLD, HLU, HUD. For HOV, the options are: VIU, VID, HBD, HUD. Selection of Orientation 
is recommended for optimized performance.

For the example: gas, (CH3)3SiH, [190], set to 50 sccm, Orientation was selected as HBD, 
and the pressure settings were left to the default. Pressing the <Configure> button brought 
up the following message. 

The recommended pressure limits for gas 190 are presented in the warning box. Click <Yes> 
to ignore, or <No> to return and reset the pressure values. If the pressure limits for a gas 
exceed recommendation, a warning message will alert the user. The user may return and 
reset the pressure values and then continue. If the outlet pressure exceeds the inlet pressure,
a message will alert the user, and the program will return to the Main page to reset the 

pressure values. 
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Figure 4.26 Main page for IFC-125C with gas 190.

Figure 4.27 Sample of recommended pressure limits warning.
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5. TROUBLESHOOTING

If any problems are experienced using the Configurator system, you should first verify that all 
cables are properly attached at both ends and that power is available to the power supplies. 
The Configurator software includes error messages that help to determine the cause of 
problems. The Table below lists these error messages and the conditions that cause them:

Error Message Caused By

Out of memory PC's hard drive is full.

MFC not found The software cannot communicate with an MFC. The MFC may not be 
connected to the EIA-485 cable or to its power supply

VBAJET32 error The VBAJET32.dll should be located in the "Windows\system" file folder 
and the "Program\Common Files\Microsoft Shared\DOA" or "\Doa.350" 
file folder. Locate the VBAJET32.dll and copy it to the folder where it is 
missing. 

5.1. Trouble-shooting the Zebra Printer

5.1.1 Status LED

What the Status LED is Telling you
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Status LED Condition 

and Color


Printer Status
 Resolution 

Reference#


Off
 Off
 1


Solid Green
 On
 2

Flashing Yellow Stopped
 3
Flashing Green Normal Operation
 4
Flashing Red Stopped 5

Double Flashing Green Paused
 6
Solid Yellow
 Various 7

Alternately Flashing

Green and Red

Needs Service 8
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Resolutions:

1. The Printer is not receiving power.
- Have you turned on the printer power?
- Check Power connections from the wall outlet to the ppwer supply, and from the power 

supply to the printer.

2. The printer is on.

3. The printer has failed its power on self test (POST).
- If the error occurs right after you turn on the printer, contact an authorized reseller for 
assistance.

- There is a shortage of memory. If this error occurs after you have been printing, turn 
the printer power off and on. Then, resume printing.

4. The printer is receiving data.
- As soon as all of the data has been received, the status LED will turn green; then, the

printer automatically resumes operation.

5. The media or ribbon is not loaded.
- Load a roll of media or ribbon, following the instruction in "loading the Media" or

"loading the Ribbon". Then, press the feed button to resume printing. 
- The printhead is open. Close the top cover. Then, press the feed button to resume

printing. 
- The cutter is jammed. Turn off the printer and remove any jammed labels from the

cutter unit. Then, turn on the printer to resume printing. 

6. The printer is paused.
- Press the feed button to resume printing.

7. The printhead is under temperature.
- Continue printing while the printhead reaches the correct operating temperature.
- The printhead is over temperature. Printing will stop until the printhead cools to an

acceptable printing temperature. When it does, the printer will resume operation.

8. FLASH memory is not programmed.
- Return the printer to an authorized reseller.

36
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5.2 Feed Button Modes

*Several problems occur when the printer is turned off, including printer darkness. After a 
period of downtime, if the printer is acting strangely, please run the RESET Sequence.

Following the Reset, it may be necessary to run the DARKNESS Sequence.

37

Power Off Mode (Communications Diagnostics Mode)



With the printer power off, press and hold the feed button while you turn on the power.  

The printer prints out a listing of its current configuration. After printing the label, the 

printer automatically enters a diagnostic mode in which the printer prints out a literal 

representation of all data subsequently received. To exit the diagnostic mode and resume 

printing turn off and then turn on the printer.

	

Power On Modes



With the printer power on and the top cover closed, press and hold the feed button for 

several seconeds. The green status LED will flash a number of times in sequence. The 

explanation at the right shows what happens when you release the key after the specific 

number of flashes.

	
Flash 							 Action

Sequence 						 




A Configuration Label prints.  ( A 40-item list!)

	

The Media Sensor calibrates and a media sensor profile prints.

 

To Reset the communications parameters: press and release the feed button 

	 while the LED flashes. The serial communication parameters reset to 9600 

	 baud, 8 bits/character, no parity, 1 stop bit, and XON/XOFF.  

	 For Autobaud synchronization: Send a ZPL II format to the printer while the 

	 LED flashes. When the printer and host are synchronized, the LED changes 

	 to solid green. Note: No labels print during autobaud synchronization.




Resets the factory defaults, auto calibrates, and saves setting into memory.




The Printer Width calibrates. While the status LED alternately flashes green 

	 and yellow, a series of stacking rectangles print on the label. when the 

	 rectangle prints to the outer edges of the label, press and release the feed 

	 button, The label width and current communications parameter will be 

	 saved into memory.

	

The Printer Darkness calibrates. A series of nine samples print, starting with 

	 the lightest and ending with the darkest image. When the desired print 

	 darkness is achieved, press and release the feed button. The print darkness 

	 will be saved into memory.



If the feed button remains pressed after a 7-flash sequence, the printer will ignore the 

button when it is released.




*
**
***
****
*****
******

*
**
***
****
*****

*
**
***
****

*
**
***

*
**

*
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6. ATTACHMENT A: DEVICENET MFCs

6.1. Description of MultiFlo Configurator Kit for DeviceNet MFCs

The MultiFlo Configurator Kit for DeviceNet MFCs P/N 535-400-1001 includes:

- MultiFlo Configurator software (CD-ROM) P/N 350-301-2000 (User's Manual is 
included on the CD as a Help File) 

- Zebra-T402 printer or equivalent P/N 001-152-1000 (not shown here) 
- 500-label set roll with high strength adhesive P/N 540-300-1058 (not shown here) 
- Anti-wipe ink ribbon P/N 001-152-2000 (not shown here) 
- Printer cable P/N 001-152-3000 (not shown here) 
- URS-20 Power Supply (not shown here) 
- Laptop Computer P/N 300-001-0005
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Figure 6.1 Typical connection for a DeviceNet MFC to the MultiFlo Configurator bench set up
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Valued Added Service P/N 535-001-0001
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Figure 6.2 Typical connection for a DeviceNet MFC to the Process Tool

Figure 6.3 DeviceNet Cabling Connections for P/N 535-001-0001
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Accessory Kit for DeviceNet® MFCs

User Guide: Assembly Instructions

Step 1 Following Figure 6.3 above, connect DeviceNet Pro PC Card Type II interface card 
(Item 1A on supplied drawing) to (Item 1C) via supplied cable (Item 1B). Connect 
all cables, but do not plug PCM CIA card into your laptop.

Step 1.a Connect (Item 1C) to (Item 2).

Step 1.b Connect Micro Female Connector (Item 6) to Micro Male Connector (Item 5).

Step 1.c Connect AC power cord (provided in kit) to Power Supply (Item 7).

Step 2 Use the SST Products for DeviceNet CD and install software per instructions on CD.

Step 3 Access the Internet, browse to http://www.mysst.com, and create an account. You 
will use this account to obtain the latest driver for your operating system for the 
DeviceNet PCMCIA Interface Card/Sealed Microconnector/SST, 
Part number: 5136-DNP-PCM-SM.

Step 4 Follow the SST instructions for your operating system to update the driver for the 
SST card.

Step 5 To check that the card is properlly installed, run provided SST DeviceNet programs 
(i.e. DeviceNet Commissioning Tool) to ensure interface card is properly installed. 
If program won't open check the interface card installation. 

Step 6 After completing Steps 1-5 the DeviceNet Field Service Kit is ready to test the 
DeviceNet network.
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7. ATTACHMENT B: MANUFACTURING, SALES, AND SERVICE LOCATIONS

UNITED STATES 

Austin, TX (Sales & Service)
Celerity
200-C Parker Drive, #600
Austin, TX 78728
Tel:  +1 512.247.9092
Fax:  +1 512.246.5590

Beaverton, OR (Sales & Service)
Celerity
9665 SW Allen Blvd., Ste. 113
Beaverton, OR 97005
Tel:  +1 503.643.5564
Fax:  +1 503.520.8834

Tempe, AZ (Sales)
Celerity
1320 West Auto Drive
Tempe, AZ 85284
Tel:  +1 480.763.2134
Fax:  +1 480.763.2210

Milpitas, CA (Corporate)
Celerity
1463 Centre Pointe Drive
Milpitas, CA 95035
Tel:  +1 408.946.3100
Voice:  +1 408.934.6301

Yorba Linda, CA (Sales & Service)
Celerity
22600 Savi Ranch Parkway
Yorba Linda, CA 92887
Tel:  +1 714.279.3500
Fax:  +1 714.921.0804 

Japan, Osaka (Sales)
Celerity
Sumitomo Seimei Shin-Osaka Kita Bldg.
8th Floor, 4-1-14 Miyahara
Yodogawa-ku
Osaka-shi 532-0003, Japan
Tel:  +81 6.6150.1581
Fax:  +81 6.6150.1606

Japan, Yokohama (Sales)
Celerity
5F, 3-19-5 Shin-Yokohama Kouhokuku,
Yokohama-shi, 
Kanagawa-ken, 222-0033, Japan
Tel:  +81 45.477.3521
Fax:  +81 45.477.3526

Japan, Kashima (Service & Manufacturing)
Celerity
3 Hikari, Kashima-shi
Ibaragi 314-0014, Japan
Tel:  +81 299.84.3188
Fax:  +81 299.84.3189

Korea (Sales and Service)
Celerity Korea Ltd.
RA-406 Sungnam APT Factory
Sungnam, Kyungki-do, 463-070
Korea
Tel:  +82 31.708.2522
Fax:  +82 31.708.2524

Singapore (Sales & Service)
Celerity Singapore Pte. Ltd.
BLK 164 Kallang Way, #07-28/29
JTC Bldg.
Singapore 349248
Tel:  +65 6744.7041
Fax:  +65 6744.1867

Taiwan, Taipei (Sales)
SCH Electronic Co., Ltd.
7th Fl., No. 128, Sec. 3
Ming Shen E. Rd.
Taipei, Taiwan 10445
Tel:  +886 22.713.6090
Fax:  +886 22.717.2072

Taiwan, Hsinchu (Sales and Service)
SCH Electronic Co., Ltd.
No.169-2 1 section Kang Le Rd 
HsinFeng Hsiang, Hsinchu, Hsien, Taiwan 
Tel: +886 3.559.0988
Fax: +886 3.559.2220

Taiwan, Tainan (Sales & Service)
SCH Eleectronic Co., Ltd.
No. 139 Min-Tsu Rd.
Hsin-shi, Tainan County, Taiwan
Tel:  +886 6.599.9889
Fax:  +886 6.599.9816

EUROPE 

Europe Head Office
Ireland & UK (Sales & Service)
Celerity Fluid Systems Ireland Limited
Ballycoolin Business Park
Blanchardstown, Dublin 15, Ireland
Tel:  +353 18.247.100
Fax: +353 18.247.101
Sales:  penglish@celerity.net

Germany & Austria (Sales)
Celerity
Tel:   +49 811.9988.770
Fax:  +49 811.9988.771
Mobile:  +49 160.9497.7238
Sales:  akeppel@celerity.net

Germany (Service)
ESL Elektronik GmbH
Am Mitterfeld 35
D-85622 Weissenfeld, Germany
Tel:  +49 89.9049.0381
Fax: +49 89.9049.0382

France, Switzerland, Spain & Portugal (Sales)
Celerity
Tel:  +33 474.182.544
Fax: +33 474.182.543
Mobile:  +33 689.872.027
Sales:  dmeneghel@celerity.net

Benelux (Sales)
Celerity
Tel:  +32 5531.0240
Fax: +32 5531.0244
Mobile:  +32 474.905.007
Sales:  mlambelin@celerity.net

Israel (Sales)
AVBA Engineers Ltd.
Ramat Gabriel Industrial Park
P.O. Box 690
Migdal Haemek,10500 Israel
Tel:  +972 66.442575
Fax:  +972 66.442577

Italy (Sales)
Microcontrol Electronic s.r.l.
Via Guiba 11
20132 Milano, Italy
Tel:  +39 02.28314420
Fax:  +39 02.2871777

Norway & Iceland (Sales)
NorGruppen As
Civ.Ing Helge Ingeberg AS
Gamle Drammensvei 94, Lierporten
PO Box 100, N-3420 Lierskogen, Norway
Tel:  +47 32.8535.50
Fax: +47 32.8535.55

Russia (Sales)
Cheliabinska str., 11-2
Moscow 105568, Russia
Tel & Fax:  +7 095.308.0523

South Africa (Sales)
Celerity
29 Marina Crescent
Panorama Parow 7500
Cape Town, South Africa
Tel & Fax:  +27 21.923894

ASIA

China, Shanghai (Sales and Service)
SCH Electronics Shanghai Co. Ltd.
No. 150, Cailun Road
Zhangjiang Industrial Park
Pudong New Aera
Shanghai, China  201203
Tel:  +86 21.3895.0181
Fax:  +86 21.5895.2569

China, Tianjin (Sales and Service)
Asian Power Technology Co. Ltd.
Teda Group, Heda Industrial Zone
Branch 4 Xing-Hua Street
Xi0Qing Economic Development
Jingang Road
Tianjin, China 300381
Tel:  +86 22.8396.6095
Fax:  +86 22.8396.6093

India
Xytek Corp.
407 Sai Pooja Chambers
P-58, Sector-11, CBD Belapur
New Bombay 400614, India
Tel:  +91 22.757.3611
Fax:  +91 22.757.1912


